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Thanks for reading ATPM.
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About This Particular Macintosh has been free since 1995, and we intend to keep it that
way. Our editors and staff are volunteers with real jobs who believe in the Macintosh way
of computing. We don’t make a profit, nor do we plan to. Our aim is to produce a fiercely
independent magazine, with multiple formats designed for easy reading rather than showing
ads. The views expressed in these pages have always been our own, and to help prove it we
do not accept direct sponsorships or advertising. We do, however, need to pay for our Web
site and other expenses, so we rely on minimal advertising, sold indirectly via Google and
Yahoo, as well as the support of ATPM readers who shop using our links.

)
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Welcome

Robert Paul Leitao, rleitao@atpm.com

Welcome to the May issue of About This Particular Macintosh! We begin our May issue
with a brief look at the news affecting the Macintosh user community and startling changes
announced by Apple about the manner in which the company will mange its customer rela-
tionships on select consumer electronics products. The company that ignited the personal

computer revolution has apparently decided to set fire to the way consumer electronics are
sold.

Apple By the Numbers

For the three-month period ended March 31, 2007, Apple reported a 36% jump in Macintosh
computer sales versus the prior year period. During the first calendar quarter of the year
(Apple’s 2nd fiscal quarter), Apple shipped 1.517 million Macintoshes worldwide. During
the same period Apple shipped 10.549 million iPod digital music players. The combined
sales activity contributed to the most successful 2nd fiscal quarter in the company’s history.
Revenue totaled $5.26 billion and net profits reached $770 million dollars. Gross margins,
due to falling component prices, were an astonishing 35.1%.

On a High Note

The March quarter’s results propelled Apple’s share price to an all-time high of $102.50
during April and finished the month’s trading just shy of the century mark at $99.80. The
April closing price pegged the company’s market overall cap (or the value of all outstanding
shares) at $86.30 billion.

Leopard Caged

In April Apple announced that the release date for Mac OS X 10.5 has been extended
to October. The company’s stated reason for the delay is the need to move talent from
Leopard’s final development to the iPhone project. Consequently, the benefit of Leopard’s
sales will be delayed to the 1st fiscal quarter of the next fiscal year.

The four-month delay in Leopard’s release provides more development time and will help
ensure the iPhone meets its intended June debut date. The iPhone is now considered the
most important new product from Apple since the launch of the original iPod in October
2001.

Matching SOX

Most of us have heard of the Sarbanes-Oxley Act or “SOX.” It was authored in 2002 in
response to widespread accounting scandals throughout corporate America and promised
much-needed reforms to stop abuse.

While SOX focused mostly of corporate governance and oversight, its provisions also
changed the rules for many companies on income recognition and the prospect of deferred
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revenue realization on products sold under certain conditions rather than immediate
recognition of sales revenue as income. Although the Act is now commonly called by its
shortened and informal three-letter name, its provisions are far too long to discuss in brief,
except to the extent that it impacts Apple’s accounting practices for the iPhone and Apple
TV. Apple may be matching SOX and its deferred revenue recognition requirements as
part of its product plans.

A New Apple Product Model?

In the quarterly conference call with analysts, Apple executives mentioned the company
would be recognizing the sales revenue from the Apple TV and the iPhone as income over a
24-month period of time. The executives mentioned the company will be adding function-
ality to both the Apple TV and the iPhone during the two-year period in which it converts
sales revenue from the products to income. Both income from sales and associated product
expenses will be deferred accordingly. This matches SOX deferred revenue requirements for
products materially upgraded after original sale over a determined life cycle. But it’s an
unmatched approach to the sale of consumer electronics.

Is Apple establishing a new product model? The Apple TV and iPhone may be seen more
as conduits for services rather than simple hardware or electronics devices. More will be
revealed in the months to come. This change in sales and revenue accounting may portend
a change in the manufacturer-customer relationship. A determined product or service life
with free functionality upgrades during the service term may set fire to the conventional
sales model the same way Apple ignited the personal computer revolution over 30 years
ago.

Rabid For Avid

At April’s NAB 2007 conference, held in mid-April, Apple unveiled Final Cut Studio 2, the
much-anticipated upgrade to Apple’s professional video production suite. With the new
8-core Mac Pro, FCS2, and Apple’s content management products, Apple is creating pro-
fessional solutions rivaling the offerings from Avid at attractive comparative prices. Apple
is apparently rabid to take sales from Avid.

Sharing the Wealth

Apple’s worldwide market share inched higher in the 1st calendar quarter of 2007, reaching
a 2.6% stake versus a 2.1% worldwide share a year ago. While the share may seem compar-
atively small, it must be remembered Apple is a virtual product no-show in the sub-$1,000
PC market. Placing virtually all of Apple’s Mac sales in the top-tier of the PC consumer
market indicates that high-discretionary income consumers are steadily moving to the Mac.

Sharing the Fun

Each month the editors of About This Particular Macintosh search the world and venture
across the digital divide to bring you the best news, views, and reviews in our easy to read
monthly format. Please join us each month as we celebrate what we call the “personal
computing experience.”
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Our May issue includes:

Bloggable: Always Use Digital Rights Protection

Steve Jobs announces that, in a joint agreement with EMI, Apple is going to sell music
without digital rights management for $1.29 a track, and some folks attack him for it? It
seems we're back out of the Bizarro World, folks. Criticism, reaction, counter-criticism and
some specialty analysis from fields outside our usual area of coverage, all in this month’s
Bloggable.

MacMuser: Pimp My Robot

Everyone—even Mac users—has to vacuum their living space once in a while. Mark Tennent
decided to let an iRobot Roomba do it for him.

Photoshop For the Curious: Moving Beyond Levels and Curves
Do you remember The Outer Limits? “There is nothing wrong with your television set. Do
not attempt to adjust the picture.” Some might believe the same for their photographs.
But, armed with tips for modifying and improving color in this month’s Photoshop For the
Curious, you, too, can adjust your photos beyond their previously known limits.

Web Accessibility: What Browsers Can Do, Part 2

Firefox and Opera on the Mac let you take some control of a Web site’s appearance and
functionality. Here’s how.

How To: XFX 6200 Upgrade For the Cube

How I re-flashed and installed a PC GeForce 6200 video card, adding dual-monitor support
and 256 MB of VRAM to my old-school Mac Cube.

Desktop Pictures: AirFest

This month’s desktop photos by Lee Bennett come from the 2007 AirFest held last month
at Tampa’s MacDill Air Force Base.

Cartoon: Cortland
More goings-on in the relationship of Cortland and Angie are revealed. Meanwhile, the
council of supervillains returns to business, and Todd is clearly ready to do his work—if
only he had any to do!

Review: Digital Photography Expert Techniques, Second Edition

The title of this book is quite misleading. It implies the art of capturing pictures with
a camera. Instead, the book describes a professional’s workflow of techniques for using
Photoshop CS2 to manipulate digital photos. An amateur photographer wanting to capture
better photos in the first place should look elsewhere.
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Review: Dock Extender
Just think of it as an extension cord for your iPod’s dock connector.

Review: Elevator
A design update to the Griffin iCurve that brings with it added portability.

Review: Pando 1.5.5.1

If you and your friends/colleagues regularly send large files back and forth, this peer-to-peer
client has a lot to offer.

Review: PocketDock Line Out USB

This is one of those “Why didn’t I think of that?” products. A small and simple device to
access a dock connector’s line audio output and USB (or FireWire) connection has been a
long time coming.

Review: Yep 1.5.2
Think of it as iPhoto for PDFs.
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Why Use a Mac?

I've said this for 12 years: “I like to do computer work; not work on my computer. That’s
why I use a Mac.” Four desktops, six iPods, three laptops later, I still feel that way.

—Grover Watson

Who's Got Your Back?

[ used to have a Quad G5 Power Mac (you know, the generation with nine fans and a liquid
cooling system above the power supply...[!]). I didn’t have it a week before I hear a slight
ticking inside under heavy CPU load. I brought the +50 lbs. beast into the not-so-local
Apple store, and had to leave it there for a few days. On picking it up I discovered they
replaced the entire processor core/radiator assembly, as it only came as a single unit. Price
tag? $1,600 for parts alone. I quickly got AppleCare, and then nearly a year later sold the
G5 for a Mac Pro (you know, the kind without the liquid cooling system. . .).

—Chris Dudar

Why does China get a bad rap? Believe me, having something manufactured in California
is no guarantee of reliability. Sometimes, just the opposite.

—DBL

I bought my first Mac in October 2004, an iMac G5 “Rev A” (the first of its kind). About
a year and a half later, it stopped sleeping at night—would turn itself off instead. So, I
configured it not to sleep and instead just black out the screen.

Fast-forward another year (it’s now almost three years old and nearing the end of the three-
year warranty I paid the extra bucks for). After a neighborhood power failure, it failed to
restart. It took a bit of coaxing, but I finally managed to bring it back to life. Another few
months later and it happened again—another power failure—but this time, the iMac was

dead.

I followed Apple’s support page instructions and determined it was the logic board (moth-
erboard). I brought it to the local Apple store and within a week got it back good as new.
They replaced the logic board, the CD/DVD burner, and the power supply. Total cost I
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wouldve paid was almost a thousand dollars! I could’ve bought a new computer for that
much! Man, I'm glad I had that extended warranty!

One thing though, does this mean I can only count on my iMac lasting another 2.5 years?
I'm a little worried.

—Jeff Chapman

This PowerBook G4 has been sent to Apple twice for repairs: first for the screen problem
that plagued this model during its early production run, and second for a misbehaving
AirPort antenna. Both were similar to Mr. Chamberlain’s description—after a brief and
fairly painless support/voodoo session with a tech on the phone, the laptop was shipped
in and returned to me in less than 48 hours, fixed. I purchased this Mac after a failure on
the previous iBook would have required repairs that I thought were greater in cost than
the value of the computer. This time I bought the AppleCare warranty, and I'm very glad
I did. Although I cannot give Apple a perfect score for the manufacture of their products,
when combined with the AppleCare warranty, they remain the best computer experiece I've
encountered either personally, within the network of people for whom I am tech support,
or at the tech businesses I am a part of.

—Michael Dingerson

Whereas the iPod can be considered “mass market,” the Mac has yet to get there. I'm
curious what the RMA rate is for iPods now that Apple’s had a few years of market
leadership under its belt. I think we all remember some of the problems in the “early
days.” (My, how fast time flies for us tech watchers; if only our biology wasn’t inverse to
Moore’s Law.)

Right now Apple is probably doing a fine balancing act between addressing demand and
not overspending on production. Until Macs are shipping like how Dells used to be, we
might still be in for short-term hiccups. Personally I've actually never had any hardware
problems with any Apple product. Note that I've had quite a few Macs over the years. So
either the reports and blogs that complain about Mac stuff being faulty are overblown, or
I am either lucky, or clueless!

I was really worried about dead pixels on my recent MacBook Pro, but thankfully didn’t
have any, and I have carefully checked. Even my iBook G4 batteries are OK (the same ones
that were recalled), and I haven’t even had time to get them replaced.

Don’t think for a second that I am not going to rant about any Apple product I buy that
gives me any hassle. But fortunately, so far, that has not been my experience.
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Just to give some color on the other side of the story, I know this guy who had his iMac
motherboard replaced twice by AppleCare, and he is not a happy camper. He said he
thinks Apple just gives him a refurb motherboard whenever there are issues, and he said
the replacement then gives him new sets of issues even when the old ones are resolved. He
even said this experience is making him think twice about buying Apple again. He did not
clarify if that meant he will get an HP computer next time around, although I highly doubt
that will happen.

—Angus Wong

Next Actions

There is a new Web based solution, ToDoist, which I have taken quite a liking to lately. It
is extremely simple, and does not have all of the fancy things that many of the other lists
have, but there is something about that that I like. Providing fewer toys and “systems,”
you find yourself reaching the “OK I know this now” wall earlier, and you start getting
actual work done immediately. The AJAX interface is quite elegant, borrowing from the
best and innovating where the best have left off. My biggest gripes are the lack of free text
queries and a somewhat arcane formatting syntax. You can use regular HTML though, I've
found. Some have complained about the date syntax, but I find it quite simple to learn and
very rapid to type in.

—Amber Vaesca

I've been impressed with iGTD, which lets you copy and paste “actionable” e-mails into
its window, lets you link to files on your desktop for actions (a simple keystroke opens the
file), and has upgraded its ability to filter according to “waiting for” and “flagged as next
action” and so on. It’s pretty good.

What I wish were better is something I have seen in my Newton life. Yes, I still use a
Newton, and have modified my usage greatly as I've had to schedule and keep track of
more and more pieces of my life. I can put some actions in multiple contexts and projects.
This is key.

What I mean is that I have a student, working on a research project, funded by a grant.
Each of these is a different kind of project. That student is being advised, the project has
other students on it, and progress reports on the grant need to be written and kept track
of. T need my actions to be connected to all three—am I thinking about Student X7 or
research project X? or grant X7 Each of these is a mental context (a Project, in GTD). The
physical contexts (where I do what I do) are not as overlapping, in comparison.

What I've done on my Newton is have my Projects (students, research project, grant, etc.)
as Names in my Name file, and I have locations in the same place. 1 can link as many of
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these as I want to a given action. When I work with a student, the Newton compiles for
me those actions related to the student; when I think about a research project, the Newton
does the same. . .and there’s some overlap, but obviously other actions are included, as well.
The Newton easily builds a dynamic list of future actions (as well as meeting times and an
archive of all past notes and actions related to each project!) and I have very little work to
do.

The Finder is actually capable of some of this, but only the archiving of notes in several
locations, and only if you either tag the file or you move aliases around from folder to folder.

For future planning, iGTD does better. Like I said, you can attach files you need to work
on in a given day, etc. In addition, they have introduced tags and links to the Address
Book contact list. This all makes for a very powerful tool that is well integrated with the
Finder and OS X. For an academic, it’s pretty good.

Good enough for me to drop the Newton? Sorry, no. I can carry the Newton with me, and
it’s been my collector for years. I have all the tools well integrated into my work life. But
if a tablet came out, were small enough, and I had iGTD running, I’d be set in an instant.

—Michael Wittmann

| just discovered iGTD this morning. |'ve added it and ToDoist to my list to check into
for the next column.
—Ed Eubanks, Jr.

Mac OS X’s Fonts, Again

[ am glad I could “try out” OS X before actually spending money on a Mac. Seeing
the incredible difference in font sharpness from different OSes on the same laptop is just
stunning. Windows XP and Linux with KDE renders fonts on my screen sharply without
giving me blurry vision and no headaces. This with font smoothing on. With OS X I'm
getting blurry vision and headaches after just 10-15 minutes. Until Apple fixes this I'm not
buying a Mac, never. If I can’t read the screen, what’s the point?

—bolle

Takeaway Lessons From Billy Madison
Thanks for your interesting editorial—today was the first time I had visited the ATPM site.

Your story reminds me of the day I found out that many industry pubs “sell” the articles
in a manner that is linked with advertising. I thought a description of that “linkage” might
be of interest to you. Here’s my story:

I worked in the printing industry for 25 years. I worked for medium-sized firms, during most
of my career (approximately 100 employees), and being a curious sort in a competitive
industry, I was always curious about other printers that we competed with—what kind
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of equipment they had, what types of jobs they printed, who their customers were, etc.
So, I read the three big magazines in our industry regularly: American Printer, Graphic
Arts Monthly, and Printing Impressions. Often there would be articles about printers we
competed with, both in California and elsewhere, and I just figured that the reporters at
these magazines looked around for stories and reported on them.

Then one day, I was pleasantly surprised to see that my company was featured in a story in
one of these industry magazines. One of the managers at our company mentioned something
about “it was all arranged by our Kodak rep,” (we used a lot of Kodak film, plates, chemicals,
and equipment). I didn’t understand what that meant at the time, but years later I found
out.

At a later date, I had changed companies, and I was working with an advertising agency,
who was working on an ad campaign that appeared in a bunch of “industry publications.”
They explained that all they had to do was buy ads in each publication, and then the
publication would write an article featuring their product—frequently disguised as a news
article about a company that used the product, instead of just a “press release” about the
product.

This blew my mind, but when I went back and looked at the printing magazine articles
about printers again, it made perfect sense. Buried inside of each article was in-depth detail
about some type of equipment that the printer used, and details about how that equipment
worked, that wouldn’t normally appear in a straight “news” article. And, of course, the
company that “sponsored” the article had a big ad in the magazine.

My friend further explained that the companies who “sponsored” the “stories” not only got
their product described in depth in the “articles,” in a believable format, but also, they
could use this “tool” to sell more products and to gain new accounts.

Here’s how that worked. Of course there was a lot of competition in the business for these
suppliers—gaining a new account for printing supplies was very lucrative, as was selling a
new printing press or scanner, etc. Since most printing shop owners are essentially small
businessmen (even in these medium-sized companies), it would be an easy matter to sweeten
the deal, by promising the owner of the shop that he could have an article in a national
printing magazine, perhaps even be featured on the cover, in exchange for purchasing a big
piece of equipment, or perhaps switching from Kodak to DuPont for materials, or something
similar. So the companies that supplied the printing industry benefitted in both ways—they
got their products mentioned within an article in a believable way, and they also were able
to promise “articles” to potential clients in their quest for new business.

Hope the above was informative.
—DBill H.
HomeDock Deluxe

I just bought the latest version (2) of the HomeDock and didn’t experience the “banding”
when watching video. Both my wife and I were pretty impressed, overall, with this unit.
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There are, of course, some issues—such as the occasional slow response of the remote and
the slow loading of album art (again occasionally). Other than that, I was surprised they
didn’t include photo navigation, but since I don’t use my iPod for photos, I couldn’t care
less. As long as I can watch video and listen to music with album art, I'm pretty happy
with it. It’s no Apple TV, but it’s close.

—Scott Lukas

Take Control of Mac OS X Backups 2.0

Anyone who knows anything about Macs knows full well that Retrospect, in all of its
incarnations, is unweildly, to understate the case. If you are an I.'T. pro, or a technician, or
an uber Unix Geek, then Retrospect is fine; but the best way to go, if you want complete
user friendliness (and reliability), is to try SuperDuper, which in spite of the silly name, is
a pleasure and a bargain as well.

I have actually had consulting gigs that were resolved by jettisoning Retrospect and demon-
strating just how stress-free SuperDuper really is.

—Mare Gray

SuperDuper is a great program indeed, but if you read the book, you’ll see why it can’t be
the sole recommendation. It only creates duplicates, and not additive incremental updates.
In other words, if you're backing up with SuperDuper every day, and corruption creeps into
your database on Tuesday, that corruption is then backed up Tuesday night, such that when
you discover the problem on Wednesday, your backup contains only corrupt data. With
Retrospect, you simply restore the database as it existed on Tuesday before that night’s
backup.

That said, Joe has an appendix entitled “Set Up a Backup System on Your Uncle’s Mac
in Seven Simple Steps” that provides seven easy steps for creating a decent, though not
perfect, backup system using SuperDuper.

Let me also address the cons mentioned:

o There are certainly parts of the book that are technical, because to over-simplify
is to do the reader a severe disservice. This is data integrity we're talking about,
and in today’s world, losing data could cause significant damage to your personal or
professional life. Anyone who is buying a book because they want to learn more about
backup so as to do it right needs to know the whole story.

o The fact that the ebook is comprehensive and up-to-date doesn’t strike me as a
negative in any way. :-) Yes, we have free updates, and yes, you can click Check for
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Updates on the cover at any point to see if there are changes that don’t warrant even
a free update. For instance, click it now and you’ll see a link to some recent coverage
in TidBITS that Joe wrote up while waiting for changes to be significant enough to
warrant an ebook update.

e Retrospect Desktop is still the pre-eminent backup program on the Mac. It’s the
only one that offers both duplication and archiving features, backup over a network
with client software, support for backing up to all types of media, and more. Yes,
it’s long in the tooth, and yes, EMC has been wishy-washy about its future, but at
the moment, it is still the most powerful and complete backup program around. We
certainly wish there was more and better competition for it, but that’s a problem in
the market, not a problem in the book.

—Adam C. Engst, Take Control Publisher

Adam, thanks for your comments and response. My concerns with the technicality, com-
prehensive coverage, and favoring of Retrospect are minor, and your counterpoints are
correct, of course.

My only “wish” for the book in a big-picture sense (that | was trying to convey in a
granular list of “cons”) is that those who need to understand parts of the backup process,
but not everything, could find it a bit more accessible. How about your uncle's Mac once
a backup strategy is in place? He needs to understand how to maintain and use it, but
Take Control. .. doesn't really offer it—at least, not at the level where he is (and likely
will remain for a while).

—Ed Eubanks, Jr.

We'd love to hear your thoughts about our publication. We always welcome your comments, criticisms,
suggestions, and praise. Or, if you have an opinion or announcement about the Macintosh platform
in general, that's OK too. Send your e-mail to editor@atpm.com. All mail becomes the property of

ATPM and may be edited for publication.
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Bloggable

by Wes Meltzer, wmeltzer@atpm.com

Always Use Digital Rights Protection

In March, Steve Jobs wrote publicly that he wanted to end digital rights management. It
was a doozy of a public letter, too, in which he lashed out at the record labels’ insistence
on treating their users like they don’t deserve the music that they own.

Now, I'd recommend reading the rest of my column anyway (and not just because it is
the most insightful piece of writing you will ever read!)—but what’s worth noting is the
skepticism from people like The Inquirer’s Charlie Demerjian, TidBITS’ Adam Engst, and
John Lech Johansen, among others. I'm not really in the habit of taking Steve Jobs at his
word, but when you publish an open letter on a subject, usually it means something.

That sound you hear is the sound of the other shoe dropping.

On Monday, April 2, the day after April Fool’s Day, Apple announced that they had reached
a deal with EMI to sell music without DRM through the iTunes Music Store. Tracks with
256 kilobits-per-second encoding, rather than the standard 128Kbit /s, will be sold as AAC
tracks without DRM for $1.29 per track, starting this month. Ars Technica has the best
recap of the technical details, for obvious reasons.

Yes, that’s right. You probably already knew that, but that depends on where this column
falls in the order that the issue of ATPM was put together, and on how slavishly you read
tech blogs or watch CNN Headline News.

So I guess Steve Jobs really did put his money where his mouth is, which is something a
lot of commentators didn’t expect. You might call this column “Mr. Jobs, Tear Down This
Wall, Part I1.”

The BBC’s Bill Thompson did not believe that Steve Jobs would agree to sell un-DRM-ed
music, and he was pretty vocal about it, in a column posted in February. It was called
“Why I don’t believe Steve Jobs.” But it’s indisputable that Apple did, in fact, announce
that they will offer music without DRM from the EMI catalogue. What does he have to
say”?

He has proved me wrong by opening up the iTunes store to non-DRM music,
and showed that I had seriously underestimated his business acumen.

He may even have done it in a way which avoids the fate of being “crushed under
foot by those who really understand the music business and didn’t sell their souls
to the record companies back in the days when they believed in DRM” that I
predicted for him in my February column.
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EMI and Apple’s action could mark the start of the endgame for music DRM,
a recognition that it can’t work and won’t work, and I approve of this.

In an interoperable world of open music we can leave it to the market to decide
which player, which store and which bands make it big, and that is a good thing.

That sounds like gracious acknowledgment of past skepticism, to me. Thompson isn’t afraid
to admit that he was wrong.

Less gracious was Cory Doctorow of Boing Boing. Of all of the skeptics about Apple’s moves
on DRM, I don’t believe anyone was more skeptical than Doctorow. He’s got a long and
proud record of opposing digital lock-ins of all kinds, and he and I happen to agree on the
Digital Millennium Copyright Act (bad) and DRM (bad). But he wrote an article for Salon
in February accusing Steve Jobs of not walking the walk when it came to his “Thoughts on
Music.” Then, without mentioning this article, after the EMI announcement, he posted a
blog entry containing the line, “I could not be happier right now.” Talk about a turnabout!
John Gruber makes a good point by nominating Doctorow for his Jackass of the Week
award.

Less gracious than even Doctorow is the Fast Company blog, which, having at least
entertained the idea that Jobs could be saying what he believes in February, then pisses
all over the announcement this month. I don’t understand the logic when blogger Alex
Pasquariello writes:

[T]his is all smoke and mirrors—Jobs and EMI are simply selling you the rights
they took from you in the first place... Jobs’ recent rants against DRM are a
ploy to distract us from the increasing number of legal challenges to its business
practices, especially in Europe.

Huh? T understand that the European Commission doesn’t understand why Apple’s pricing
for iTunes tracks varies from country to country, but I've never understood why that’s
antitrust. McDonald’s charges different prices for the same hamburger in different countries;
Apple has prices in their conventional nice, neat marketing numbers for each currency where
they sell music, so that a track in the US is 99 cents, in the U.K. it’s 79p (about $1.60),
and in the EU it’s 99 eurocents (about $1.35). I suppose Apple could charge 89 eurocents
and 49p, but at some point it ends up being an argument about purchasing price parity
and the Fconomist’s Big Mac Index.

Anyway, I am unclear why the DRM announcement would do anything to deter EC regula-
tors. C’mon, guys. Thankfully, I don’t have to do all the heavy lifting here: MacUser’s Dan
Moren gives Pasquaiello a good, stiff fisking by attempting to figure out what this means.

Similarly curious is Engadget’s response to the announcement:
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Asking customers to pay 30% more for no DRM and a higher bitrate is a dis-
traction, a parlor trick to take our attention away from the philosophical issue:
EMI is still selling DRMed music.

At least they make sense; their objection is that Apple is charging more for these un-DRM-
ed tracks than for the standard DRM tracks. I say, $1.29 a track is still a better deal than
a whole album, considering the $16 I paid for the last CD I bought, unless there are more
than 12 tracks on that CD. But if nothing else you would think they would be a little more
pleased.

But not everyone was so curmudgeonly in their praise for what seems to be a genuinely
good move for the 99 percent of us who don’t want DRM on our iPods.

David Pogue, for instance, shows a little understanding that Engadget didn’t: not only does
he call this “an absolutely huge, industry-shaking development that I never in a million years
would have imagined,” he notes that the extra 30 cents is in essence a piracy tax that EMI
and Apple levying against customers. Sure, I know that All Taxes Are Evil, but I think
that’s a reasonable perspective to take. He writes further:

Whatever happened to the head-in-the-sand recording executives who are terri-
fied of the Internet and at war with their own customers?

Somebody over at EMI, no doubt helped along with some persuasive mojo from
Steve Jobs, recognized that copy-protecting your legitimately sold songs doesn’t
inconvenience the music pirates in the least. The only people it bothers are the
law-abiding customers who pay for their music.

Congratulations all around on this triumph of common sense.

The Economist took an even stronger rhetorical approach than Pogue on DRM, generalizing
from the Audio Home Recording Act of 1992 and a recent Santa Clara (Calif.) Superior
Court decision about DVD copying to legal CD ripping and the EMI-Apple deal. The
magazine writes:

[M]usic executives have come to realise that DRM simply doesn’t work. It is
supposed to stop unauthorised copying, but no copy-protection system has yet
been devised that cannot be easily defeated. All it does is make life difficult for
paying customers, while having little or no effect on clandestine copying plants
that churn out pirate copies.

Om Malik (at GigaOm) says that this is a victory for Apple, because Jobs called the record
industry’s bluff and now the other labels have to play the game or go home. Ars Technica
seconds this in two looks back at the announcement: In their Infinite Loop blog, Charles
Jade says the EMI announcement may have killed the music labels’ desire for a subscription
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model once and for all, and Iljitsch van Beijnum notes that the record labels got the old
Weimar knife-in-the-back from EMI, since this was all EMI’s idea.

Most important of all, Rui Carmo points out the caveat I guess we’'ve all known all along:
Some people won’t ever be happy with what Apple does. It will never be enough. (Viz.,
Cory Doctorow.)

There are a couple of other distinctly original takes on the topic that I saw while I was
researching this month’s column, and I thought I’'d share ’em with you before we move on
to other topics. I will pass them along without comment, because I don’t know enough to
evaluate them:

o At the University of Chicago Law School Faculty Blog, Randy Picker posts that Ap-
ple’s strategy isn’t all that different from Lexmark’s differently-priced printer cartridge
scheme, which did not really work out for them. (In fact, I seem to remember that
the Sixth Circuit ruled against them, and the Supreme Court wouldn’t hear the case.
I wonder how Apple would react to someone selling DRM-stripping software for iTMS
tracks.)

o David Weiss writes about how the EMI deal demonstrates that Apple has “deep trust
in the inherent value of their products and the experiences they provide,” rather than
the anti-competitive lock-in that DRM promotes.

o Antitrust Review’s David Fischer suggests that, rather than being a piracy tax, the
extra 30 cents for a DRM-free iTMS track is just the added value of not having DRM.
There’s an interesting perspective for you.

On that note, ladies and gentlemen, I'm going to wish you a terrific May. I'd also like to
note that I'll be taking a hiatus from June’s issue, due to some major real-world projects
that will require many man-hours in May. We’ll be back in July!

Copyright © 2007 Wes Meltzer, wmeltzer@atpm.com.
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MacMuser

by Mark Tennent, mtennent@atpm.com

Pimp My Robot

Sometimes life is too short to do boring things. Our office is within a mile of the town
center, just off the seafront in sunny West Worthing. Snow? What snow? This town used
to be seriously uncool but now it is the secret jewel of Sussex, only ten minutes commuting
time on from Brighton. I spent last week mowing the lawns because the grass was so long
it had bent double. Four grass boxes full, quadruple a normal summertime load. I would
much rather have gone for a lunchtime walk along the prom, round the pier, and back via
Marks and Sparks for a sandwich and some milk.

What I needed was a robot grass cutter, but I doubt it would have been able to tackle the
rough pasture our lawns had become. Unlike their robotic siblings, the vacuum cleaners,
which are so good that I cannot understand why every home and office doesn’t have one.

We got our first iRobot Roomba last November, bought direct from the US—where, like
Amazon and eBay USA, we buy a lot of kit to avoid the inflated prices we see in Britain,
a.k.a. Treasure Island. Google for stores selling the kit, telephone them, pay by card, and
arrange shipping to the UK. Not forgetting the six- or seven-hour time difference, as I did
the first time I called Montreal and woke the shop owner from deep sleep in the early hours.
The cost of the robot plus delivery was about a hundred quid ($200 at publication time).
Major manufacturers selling in Europe such as Electrolux, Samsung, and Karcher are also
doing them now but at a rip-off six to nine times the price, and many look like rebadged
iRobots.
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These cleaning robots seem flimsy at first, but turn them over to see the heavy-duty in-
dustrial motors and power packs. Set them to work and they happily scurry around from
room to room, cleaning far better than we could ever be bothered with a standard vac-
uum cleaner. When we empty the robot’s waste bin it seems to have found a never-ending
source of horsehair from our oak floors. Our robot has a strange relationship with the nest
of snakes that live under our desks, and we find ourselves arranging furniture to suit the
robot. He is often to be found “mounting” the base of our circular table as well. Best of all,
he automatically takes himself back to his recharge station so all we do is press the start
button and leave him to do the house and office all by himself.

Of course it had to happen. There are already magazines, books, and various Web sites
telling how to hack the robot. The manufacturers even make one with a USB port. We
anthropomorphise our little chap, but some owners have taken things to the extreme, pimp-
ing their robots to ridiculous extremes. We haven’t gone quite that far, just found ours a
corner to live in and chat to him as he buzzes around cleaning up after us. We are planning
to get him a little friend, the iRobot Scooba that washes the floor as well as cleaning. If it
could clean out my hard disks every now and again, so much the better.

Copyright © 2007 Mark Tennent, mtennent@atpm.com.
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Photoshop For the Curious

by Lee Bennett, Ibennett@atpm.com

Moving Beyond Levels and Curves

Levels and Curves Follow Up

After I turned in last month’s column, I received a comment saying I only described how
to use the Levels and Curves adjustments and didn’t really touch on when or why to use
them. This troubled me but, after a bit of thought, I realized why I didn’t suggest when
or why. It’s not a hard rule or science. I can think of no set of conditions where you
must always perform a particular adjustment. Sure, there are plenty of times where a
particular adjustment would be preferred by most people. However, at the end of the day,
it is completely up to your tastes (or your client’s tastes!) to decide when and why to make
adjustments to photos.

The best advice I have to offer is to really look at your photo. Study it. Critique it. Does
it really need to be lightened or darkened? When you first look at a photo, is a distracting
highlight the thing that catches your eye instead of the main subject? You really are your
own best critic, and never let anyone else tell you otherwise.

With that in mind, I will take a risk and say that, more often than not, my photos often
get a slight bump lighter in the 70% region (remember, my brain works best when I think
of 100% as white but if you like 100% as black, then it’s the 30% region), the red hues
are diminished a little bit, then the overall color saturation is kicked up a little. This s
not a universal procedure I apply to every single one of my photos. It’s only a common
procedure. I tend to like my photos a little bit lighter and a little less red than what most
digital cameras capture, and a subtle boost in saturation is often (but not always) a good
thing.

You're welcome to try this series of adjustments and see what you like. But, when using
both the Levels and Curves adjustments that were discussed last month and some of the
other adjustments we’ll cover this month, I urge you to remember that the end result should
be what you like—not what someone else thinks you should like.

Do Not Adjust Your Television Set. ..

Let’s have a look at the Image > Adjustments menu:
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Levels,.. £

Auto Levels 3L
Auto Contrast 4L
Auto Color B
Curves... 3£ M
Color Balance... ]
Brightness/Contrast...
Hue/Saturation... FEU
Desaturate a®#U
Match Color...

Replace Color...
Selective Color...
Channel Mixer...
Gradient Map...
Photo Filter...
Shadow/Highlight...
Exposure...

Invert |
Equalize

Threshold...

Posterize...

Variations...
.

The Adjustments menu. Last month, we covered Levels, Curves, and Brightness/Contrast. The additional
Adjustments menu items are on this month’'s menu.

In the upper third of the menu, along with Levels, Curves, and Brightness/Contrast, you’ll
also see three Auto items plus the Color Balance command. There’s no mysticism to the
Auto commands. They really do simply perform an automatic adjustment using either the
Levels or Brightness/Contrast interfaces, or a color adjustment using the Color Balance
command that I'll describe below. Go ahead and try them if you wish. If you don’t like
the results, just hit the Undo command.

Remember, I said above that adjustments should be done according to your taste. If you
like the results from an automatic adjustment, then it’s perfectly acceptable to use the
Auto commands, as long as you remember that an automatic adjustment isn’t always the
best adjustment. Also remember that I personally would steer away from Auto Contrast
for the same reasons not to use the Brightness/Contrast adjustment (go back and read
last month’s column if you don’t know why not).
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Color Balance
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Think of the Color Balance adjustment control as the tint control on your television—on steroids.

I revealed above that many of my photos often receive an adjustment to diminish the red
tones. You might have wondered how difficult that is to accomplish. It’s insanely easy.
When you open the Color Balance window, you’ll see three sliders. Each slider performs a
color shift toward complementary colors: Cyan and Red, Magenta and Green, and Yellow
and Blue. As an alternative to saying that I diminish the red tones, it would be equally
accurate to say that I increase the cyan tones. By increasing the cyans, I reduce the reds.

Like most all of Photoshop’s adjustment controls, subtle changes are almost always the key.
Though the control allows for much more, I seldom go more than 10 levels towards Cyan.

Again, I urge you to study your photo, and this is why it’s important for your monitor to
be reasonably calibrated. As you look at the image, does it seem like it has a green cast
to it? Just bring up the Color Balance adjustment window and move the slider away from
Green and toward Magenta a little bit.

Last month, I suggested that most Levels or Curves adjustments will occur in the midtones
region. The same is true for making color adjustments. That’s where your eye sees the
most color. Conversely, shadows are generally already black enough and highlights white
enough. Adjusting the color in highlights might just serve to make white clouds appear
yellow, for example. But maybe that’s the effect you're going for!

Finally, you’ll almost always want to leave the Preserve Luminosity option checked. When
it’s enabled, as you adjust the color sliders, the image will remain at the original luminos-
ity (or brightness, if you prefer). If it’s unchecked, your image can get lighter or darker
depending on which colors you are adjusting.
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More Adjustments

The remainder of the Adjustments menu is where you can have a bit of fun and make some
crazy-looking photos. Some of the items are better left for advanced users, so for those
items, I'll just give a short description of what the command is for.

Hue/Saturation
Hue/Saturation
Edit: I Master I :] E
o |
- AN
N e
Saturation: 0 -
=
Lightness: |ID |
&
1 Colorize
f /’? f E Preview

The Hue slider is also like your television’s Tint control—only not on steroids—and the Saturation slider is the
Color knob.

This is the panel used to give color saturation a boost. Again, there’s no mysticism to
these sliders. Give them a try. The Hue slider will make radical color shifts in your images,
so take it easy. The Lightness slider you may generally want to leave alone for the same
reasons not to use the Brightness/Contrast adjustment control. For some real fun, click the
Colorize checkbox. Your image will look like it was drenched in a single color, and the Hue
slider will change that color.

Also note the Master item visible in the pop-up menu. By default, these sliders will affect
all the tones in your photo. But suppose you only want to increase the saturation in the
sky, but leave the rest of your photo alone. Just select Cyans in that menu, and all the
sliders will now only adjust the cyan colors. After choosing to edit something other than
Master, you can even click somewhere in the photo to hone in closer on the exact colors you
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want to adjust. Advanced users will even use the eyedroppers with the 4+ and - symbols to
widen or restrict the range of colors on which they want to work.

Desaturate

There’s not much to say here. The Desaturate command is the same as opening the
Hue/Saturation window and pulling the Saturation slider all the way to the left.

Match/Replace/Selective Color

Beginning Photoshop users probably won’t have much use for these advanced tools. 1
certainly don’t use them frequently. In fact, I don’t believe I've (yet) had a reason to use
Match Color at all.

Replace Color, however, can be handy for performing a Hue/Saturation command on a
specific range of colors. Replace Color works almost exactly like the Hue/Saturation ad-
justment window, except that it includes a preview representation of which colors will be
affected.

Selective Color is another tool you can pass on for now. I use it on photos that are bound
for a commercial offset press. If you are familiar with the concept of total ink density and
are interested in making sure the dark shadows in your photos don’t plug up on the press
with too much ink, e-mail me and I'll describe the procedure.

Channel Mixer

The Channel Mixer is another advanced adjustment destined for an advanced class, but
do remember from my earlier tutorial that this is the window where you can make better-
looking grayscale photos by clicking the Monochrome checkbox before changing the Image
> Mode to grayscale.

Gradient Map

OK, time to have some fun. The Gradient Map adjustment won’t be of much use for making
subtle improvements to your photos, but if your goal is to create something kind of trippy,
this is definitely a tool you’ll want in your arsenal.
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Gradient Map
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To create wild colors with the Gradient Map, you start with no colors at all—only grayscale.

To understand how the Gradient Map adjustment works, you’ll first need to think of your
photo in terms of grayscale. This isn’t to say that you must first convert your photo to
grayscale—only to think of it that way. The Gradient Map is going to make adjustments
based on each equivalent grayscale shade in your photo. You start with a basic black-to-
white gradient selected in the Gradient Map adjustment window. You’ll note that your
photo has temporarily changed to grayscale. Now, just remember that the black-to-white
gradient in the Gradient Map window corresponds to the same shades in your photo. The
shadows are represented on the left side, and the highlights are represented on the right
side.

Now, suppose the right side of the gradient were orange instead of white?

ATPM 13.05 28 Photoshop For the Curious



L La] = Northeest 1993 077 PG & 50K (RGBE)

Cradient Map

Gradient Uiad for Grayicale Mapping E

{ Cancel )
™ Preview
Gradies Dpticers
| Digher

Bpvprie

R DN - |
Presto chango! Black is now purple, and white is now orange!

You’ll remember the direction of the gradient when we first started. That same gradient
now has purple on the left and orange on the right. The corresponding blacks, grays, and
whites in the photo now match the gradient color that was chosen with the pop-up menu.

If you clicked the actual gradient instead of the tiny pop-up arrow on the right, the Gradient
Editor appeared. This editor is where you can customize the colors and their positions
instead of picking one of the default gradient choices.
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Surreal-o-Vision!

In the above image, I started with the default chrome gradient and adjusted the color stops
in the lower portion to make the colors blend better in the photo. When you click on one
of the color stops, you’ll notice small diamond icons between the stops. These allow you
to define the 50% point between two color stops. It’s difficult to describe in words. Drag
one left and right and watch how the gradient stretches and compresses. You'll see what I
mean.

Photo Filter

The Photo Filter adjustment is perfect if you haven’t invested in a set of lens filters for your
camera. It allows you to apply the same effect to your image as if you had a corresponding
lens filter attached to your camera. Presents include six common warming and cooling
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filters (three each) in addition to several other base color presets. The specific color can be
fine tuned as well as the perceived density of the filter.
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The Sepia preset with about 50-70% density is one of my favorites.

Shadow/Highlight

The Shadow/Highlight adjustment window, in its simple form, is nearly identical to using
the Shadow and Highlight sliders in the Levels adjustment window. The difference between
the two is that the Levels window lets you see in a histogram where particular shades of color
are, and the Shadow /Highlight window lets you make adjustments in specific percentages.
As for the advanced version of the Shadow/Highlight adjustment, I'm not ashamed to be
honest: these controls are beyond my experience, so we’ll leave them be.

Exposure

If you're an advanced photographer and are familiar with exposure units, offsets, and gamma
settings, here’s where you can tweak those values. Otherwise, feel free to pass on this
advanced tool as well.

Invert

If some of the previous commands seemed complicated, here’s one that is most definitely not
complicated. There aren’t even any adjustment sliders to deal with. It’s a single-shooter
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command that will invert the colors (or gray shades) of your image into a negative and vice
versa.

Equalize

Equalize is something of an auto-adjustment command. It tends to work less aesthetically
than Auto Levels or Auto Contrast. Instead, it goes more by the numbers. It will find
the darkest and lightest pixels of your image and make them black and white, respectively.
Then, as the name suggests, it will equalize all other colors as evenly as possible. While
this will typically increase contrast in your image, it often becomes too dark or too light
overall. Sometimes, though, I've really liked the results.

Threshold

You might recall when I said that referring to a photograph as black and white is some-
thing of a misnomer and that it should really be called a grayscale photo. The Threshold
adjustment is one way to make a true black and white image.

Threshold
Threshold Level: (128 Fook
Carizl
?qu‘.-lrﬁ-

No shades of gray here.

When you access the Threshold adjustment, every pixel of your image will become either
solid black or solid white. The “threshold” of whether a pixel becomes black or white
depends on the location of the slider. A value of 128 is equivalent to 50%. Everything
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above (to the right) is white, and everything below (to the left) is black. Moving the slider
simply defines where the switch from one to the other occurs.

Posterize

Another fun adjustment—Posterize starts similarly to the Threshold adjustment, but adds
in other colors besides black and white—the number of additional colors is chosen in the
Posterize window. You don’t have control over which colors are used. They are automat-
ically chosen based on the average color in various regions of the photo. The higher the
number of levels, the more natural the colors in your photo will appear.

L NANA] " Morttweesi 1959 077 PG & SR (RGE/ B

ey y
Levels: [§ | 0
( Camcel )

¥ Pravigw

[Ep—

- - o s e 3 -
R — _mq..-::_.:;u.i'," apm g - — 3
i o ., o

.

e REa e ] L

With this setting, the image is represented with only five different colors plus black and white.

Variations

If using the Color Balance and Hue/Saturation adjustments is just too much control for
your comfort, try the Variations adjustment instead. With it, you can add or remove various
colors in a plain-English interface: More Red, More Yellow, etc.
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The Variations adjustment window offers simple and quick color shifts to photos.

Using the Variations adjustment window is probably about as close as you'll get to satisfying
an instant gratification tendency. In the screenshot above, I moved the slider toward Coarse
to better show the possible changes to color and brightness. In real life, you’ll probably
want to use a more Fine setting.

It should be apparent that any color adjustment in one direction can be reversed by selecting
the adjustment in the opposite direction. More Cyan equals less Red, and more Red equals
less Cyan, and so on.

As with the Color Balance adjustment, you can make changes to the midtones as well as
the shadows and the highlights. Also note the Show Clipping checkbox. It’s good to leave
that enabled, as it will reveal when a color has reached a maximum.

Homework Assignment

Your homework for this month is perform color improvements on some of your own photos.
You may have a few favorites that you’d like to work on, or you may have some photos
that might have been your favorites, but the color isn’t what you had hoped. Even though
I said above that, ultimately, you are your own best critic, it still doesn’t hurt to have a
friend or family member look at one of your adjusted photos and have them tell you what
they think. You might even want to let them compare before and after.
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Even though I'm probably sounding like a broken record, I'll remind you to never work on
your original photo file. Make a copy and work on that. Keep your original safe—mno matter
how much color correction it needs.

If you don’t have any suitable photos to experiment on, you can try this one:

Sample photo for color correction experimentation. This version is the original, scanned from a negative, with
no adjustments to levels, curves, or color.

Compare it to the adjusted version offered last month as part of our desktop picture series.
See if you can make the original version above look closer to the version that appeared last
month.

Topics For Upcoming Months
« What Does “Dots Per Inch” Really Mean? (A Tutorial On Resolution)
o Effective Layer Effects

o Conjuring Speech/Thought Bubbles

Creating Seamless Tiles

o Mask-erades
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e Fun With the Automate Menu
— Photomerge
o Fun With Filters

o File Format Fever

If you have a topic suggestion, please share it. I'm definitely interested in expanding this
list with topics that are of interest to you.

Copyright © 2007 Lee Bennett, Ibennett@atpm.com.
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Web Accessibility

by Miraz Jordan, http://mactips.info

What Browsers Can Do, Part 2

Part 1 of this article considered the abilities of Safari, but Firefox and Opera are two major
browsers that Mac users may also have in their toolbox. Both browsers are free.

This article shows how to use Firefox and Opera to take control when you use a Web site.
Because Part 1 covered a lot of background, you may wish to read that article first.

Firefox

Firefox is very popular with Web developers in particular because of the huge list of optional
extensions you can install.

Opera
Opera is known for its accessibility features, including the ability to zoom in on a page,
enlarging both text and images.

Block Pop-Up Windows
Firefox and Opera are both set by default to block pop-ups.

Firefox’s exception list is where you can add the URLs of sites whose pop-ups you want
to see. Go to Preferences > Content and click the “Exceptions...” button beside “Block
pop-up windows,” then follow the instructions in that window.

In Opera you can modify the preferences, including for pop-ups, for individual sites:
Quick Preferences > Edit site preferences. . .

Site preferences are also available under the General Preferences in the Advanced > Content
section, and from a contextual menu reached by Control-clicking on a blank part of the page.

Status Bar

As with Safari, Opera’s status bar is disabled by default. To enable it, choose View >
Toolbars > Status bar.

Choose View > Toolbars > Customize. .. to modify characteristics of all toolbars, including
the status bar. If you like you can move the status bar around too.
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Text Size

In Firefox you can use the standard Command-Plus keystroke to increase the size of text
on a page. Press Command-Minus to reduce it again. These commands are also available
under the View menu. While you can enlarge or reduce text, the images remain the same
size.

Opera handles this quite differently, using Shift-Plus and Shift-Minus, instead of the more
usual Command-Plus/Minus. Moreover, the images also increase or reduce in size, along
with the text.

Along with commands under the View menu, Opera also has a toolbar item for the zoom
feature: click the spectacles icon beside the Google search box to make an additional toolbar
visible. Choose a zoom amount from the pop-up menu.

Minimum Text Size

As with Safari, you can set a minimum font size:

Firefox > Preferences > Content > Fonts & Colors > Advanced

Opera > Preferences > Advanced > Fonts

Hide and Display Images

Would you like to turn off images? This feature is useful for Web designers, but also for
those in a hurry, or stuck with a very slow or expensive connection.

While text is generally quick to load and accounts for very little bandwidth, images, sound,
and video chew through the megabytes.

Firefox, like most browsers, shows images by default, but you can set it to disable images.
Again, you can set exceptions for certain sites:

Preferences > Content > Load images automatically
Opera provides more tools for dealing with images: set a general preference, set a per-site
preference, or use a toolbar button.

Once a Web browser has displayed an image, it is stored in a cache on your computer so
it loads more quickly next time you need it. With Opera you can choose “Show images,”
“Cached images,” or “No images.”

Preferences > Web pages > Images
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Click the spectacles icon beside the Google search box to make an additional toolbar visible.
The third button from the right toggles between “Show images,” “Cached images,” and “No
images.”

Choose Your Own Stylesheet
Firefox allows you to view a page without the stylesheets the designer assigned:

View > Page Style > No Style

With free extensions you can do much more. See the section below on Firefox extensions.

Opera allows you to choose your own stylesheet for individual sites. Try downloading
my-styles.css and then choose it as a custom stylesheet:

Opera > Quick Preferences > Edit site preferences. ... > Display > My style sheet

Caution: if you’ve changed the stylesheet for a particular site, it’s not possible to change it
back to the default, which resides at:

Opera.app/Contents/Resources/Styles/user.css

To reset, remove the site from the list of sites whose preferences you are managing:
Preferences Advanced > Content > Manage site preferences. . .

There is a great deal more you can do with stylesheets in Opera, though. See Opera’s
Author Mode below.

Disable Scripts, Add-ons, and Plug-ins

Some Web designers use scripts to change your browser window, perhaps disabling or chang-
ing the content of the status bar, moving or resizing the window.

Firefox lets you manage this:
Preferences > Content > Enable JavaScript > Advanced. . .

If a site tries to install add-ons without your knowledge or permission, Firefox warns you.
It also allows you to change and customize the behavior:

Preferences > Security > Warn me when sites try to install add-ons ©
Exceptions. ..
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Opera’s Quick Preferences allow you to enable and disable JavaScript and Plug-ins on the
fly, but you can also choose settings in the general Preferences window:

Preferences Advanced > Content

As with Firefox, you can allow and disallow particular JavaScript behaviors, but you can
also use your own JavaScript files:

Preferences Advanced > Content > Enable JavaScript > JavaScript options. . .

Opera’s Block Content

Control-click on a blank part of a Web page in Opera to bring up the Contextual menu
and choose Block content.... This is also available under Tools > Advanced > Blocked
content. . ..

Now click on items such as images or plug-in content and they will be blocked for that site.
Opera’s help points out:

You can block all content that shares the same file path on a server, or you can
block single files, or both.

Firefox Extensions

Many people have created add-ons, or extensions, for Firefox. Click on Tools > Add-ons to
bring up the Add-ons window, then look at the Extensions tab.

This window displays any extensions you may have already installed, allows you to set
preferences, disable or uninstall them, or click the Get Extensions link to find more.

There are hundreds of extensions available, for all kinds of purposes including blocking ads,
customizing your view of a Web page, and clipping sections of pages. If there’s something
you want to do with a Web page, there is probably an extension for it.

Web designers should be sure to install Chris Pederick’s Web Developer extension, which
lets you analyze the elements on a Web page, edit stylesheets, validate pages, and so on.

Opera’s Author Mode

Opera has a long-standing history of including accessibility tools. One of the very interesting
tools is User Mode.

Call up a Web page, then go to the View menu and look under the Style submenu. Start
with “Author mode,” which should be the default. This should give you a normal view of
the Web page as the designer intended it.
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Now choose “User mode” and try out some of the many alternative user stylesheets, such
as “Accessibility layout,” “High contrast,” or “Table of contents.” It’s possible to check
more than one item at a time, so for the clearest results uncheck the item you’ve just tested
before trying another one.

Web designers will find some of these possibilities very helpful, for example “Class and id”
displays elements with a class or ID, together with the class or ID name.

Summary

While Opera and Firefox both have similar tools and preferences to Safari for enlarging and
reducing text size, blocking pop-ups and so on, both also include many features that give
users much more control over a Web page they are visiting.

Anyone who makes Web pages will also find Opera and Firefox vital additions to their
toolbox, because of their capacity to reveal what’s behind the scenes of a Web page.

Copyright © 2007 Miraz Jordan, http://mactips.info. Miraz is a co-author of the recently published
book: WordPress 2: Visual Quickstart Guide, and member of the Webstock organizing team.
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How To

by Matthew Glidden, mglidden@atpm.com

XFX 6200 Upgrade For the Cube

Some time ago, my Cube’s original ATI Rage 128 Pro video card needed replacing. Relative
to newer models, it ran slower than uphill molasses and supported a limited range of monitor
sizes. With the help of folks at CubeOwner, a beefier ATI 7500 Radeon stepped in for the
ATT 128 and achieved video bliss—at least for a little while.

Early this year, my long-lived Formac LCD monitor flashed, smoked, and dramatically gave
up the ghost. Suddenly, I needed a new monitor. It’s no problem finding a replacement,
but the new crop of wide-screen choices made me envious—and the Radeon 7500 couldn’t
support a roomy 22-inch model, with 1680x 1050 resolution.

When I bought the 7500, you could also find high-powered GeForce3 cards specially modified
for Cubes. Unfortunately, they ran close to $200 each. I needed value more than top-shelf
performance, so went with the $50 Radeon. It worked for me then, but wouldn’t be enough
now.

Time Waits For No Man

Fortunately, technology moves along, even for old computers. In 2007, Cube owners
don’t have to settle for the hard-to-find GeForce3 cards. The video card tweaking
site Strangedogs, a repository of video card know-how, provided an option I previously
thought impossible. Reformat a PC GeForce 6200 for dual-monitor support! DVI output!
16801050 resolution! 256 MB of VRAM! Apple’s new Core Image support! An extra
supply of exclamation points to describe it all!

I last used multiple displays on my Power Mac 8500, which came ready for two monitors
(plus a TV output) if you spent an extra $50 on a whopping 4 MB of VRAM. A decade
later, the XFX GeForce 6200 includes 256 MB for the same upgrade cost. This means

bigger monitors, such as a typical 22-inch model or Apple’s Cinema Displays.

There’s a very large catch to the nVIDIA XFX GeForce 6200—it’s a PC-based video card
that you're reworking for the Cube (bringing it over from the Dark Side, as some say). This
setup requires some special work.

Note: This article describes an actual upgrade, but provides no warranty for your own work.
See an Apple Store or customer support if you're not comfortable opening up the system.

Strangedogs describes how to reformat (flash) the XFX 6200 on their Wiki site, which I
summarize below. Use their page as the main reference—my version adds personal context
and experience. However, don’t use their ROM software or information for commercial use,
as it represents a great deal of personal labor by the volunteers there.
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1. Purchase the Cube-sized XFX GeForce 6200 model PVT44AWANG (and only
this model), probably from eBay or an online reseller (mine cost $50).

2. Find a friend with a PC that supports PCI cards (if you don’t have such a PC
yourself).

3. Make a bootable Windows floppy disk.

4. Download the appropriate XFX 6200 ROM file from the Strangedogs Wiki (they
have a Cube-specific version that’s slightly under-clocked to run cooler).

5. Install the 6200 in the PC and follow the NVFLASH instructions to reformat
the card.

6. If all worked so far, install it into your Cube.

7. If it powers up and shows the Apple icon, rejoice!

Before making this upgrade, I'd already taken apart my Cube several times to replace the
motherboard, add a fan, do the Radeon 7500 work, swap the hard disk, add a DVD burner,
put in more RAM, install an AirPort card, attach a wireless antenna, and upgrade the CPU
twice.

Don’t disassemble your Cube casually! The pieces inside don’t react well to dust, static
electricity, or missing components. Ground yourself, organize all parts you remove, and
work carefully with instructions. (Adding the 6200 took just as long as upgrading the
motherboard for me!)

Cooling vs. Silence (or “Buy a Fan Now”)

Cube owners generally like quiet things, and avoid installing a fan if at all possible. The
XFX GeForce runs relatively cool, given its memory and speed—but you will absolutely
need a fan to use it. You can get something very quiet that runs on the existing power
supply. Buy a fan because a quiet hum is vastly better than your CPU overheating.

The XFX 6200 didn’t come with a fan, but my Cube already had one from a previous CPU
upgrade. If yours doesn’t, find a suitable model (this example uses the Panasonic Panaflo).

Finding the Card

You can find the XFX 6200 PVT44AWANG on eBay or at other online stores for $50—
60. The XFX 6200 came out recently enough that you should find something brand new.
If you're shopping second-hand, make sure the seller has a dead-on-arrival replacement
guarantee!

Doing the PC Work

Putting the video card into a PC allows you to flash its on-board software (or ROM),
replacing the PC-friendly version with something the Cube can understand. You spend
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some important time at a PC keyboard for this upgrade. Make it count by following the
Strangedogs upgrade instructions carefully! They cover the main points, so I'll just add
personal notes.

1. Tused NVFLASH version 4.42, not the latest 5.x version. For some reason, 4.42
flashed the nVIDIA card properly where the newer version reported an error.

2. You can create any kind of Windows boot disk, even a CD-ROM disc or USB
drive! Just make sure to add the NVFLASH version and ROM files and name
them with the 8.3 format (i.e., nvflash.exe and XFX6200.rom), since you'll be
booting into DOS.

3. Flashing a ROM seems really intimidating. NVFLASH gives you a bunch of

warnings and shows lots of cryptic output. Rest assured it has worked with this
video card model, ROM, and Cube!

4. This might not work the first time, the second time, or the third time! Don’t
be afraid to check the Strangedogs forums and repeat steps when in doubt.

5. You need to cover two pins on the video card with tape. This requires a steady
hand, a sharp utility knife, and patience.

All this effort makes it extra-satisfying when things ultimately work out. It’s work any
PC geek can respect! My optimism aside, the work is still in your hands and my article
provides no warranty or guarantee of final performance.

Bracket Surgery

The XFX 6200 already fits in the Cube lengthwise or it wouldn’t work at all. You need to
modify the case (or bracket) slightly to fit the width. Start by reading the excellent (and
illustrated) Fly-Productions guide to this process.

I chose not to modify the case as shown in Step 1. This leaves you short one DVI port
anchor screw, but shouldn’t sacrifice much stability since the Cube doesn’t move around.
Fly’s last picture shows the nut you must install to keep the card steady inside.

Installing the Card Itself

Once you flash the card and modify its mounting bracket, it’s time for actual Cube instal-
lation. Using all previous precautions, slide out the Cube and remove the top plate screws.
Carefully move the plate aside (you shouldn’t have to unplug the on-off switch) to make
room for swapping the video cards. Test the fit of the new card, which should go right into
place. If a hole doesn’t line up properly, don’t be afraid to rework the 6200’s mounting
plate! Rushing through these steps won’t make the card run faster.

Check the placement of the tape on the video card’s pins before it goes in. Should the Cube
fail to power up after installation, try re-taping the pins. (I had to do this once—see the
Pins 3 & 11 page on the Wiki for the reason why.)
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After installation and before reassembly, push and hold the Cube’s CUDA switch for a few
seconds (it’s on the corner of the mother board away from all the ports). Apple recommends
this after any internal hardware change.

With all that done and the Cube reassembled, I connected a pair of monitors to the DVI and
VGA ports. The 6200 promised much better video performance, but running an extended
desktop was my real reason for the upgrade. After power up, System Profiler confirmed

what I had.

Contents | Geforce 6200:
¥ Hardware '
ATA 'T Chipset Model: Geforce 6200
Type: Displa

Audio (Built In) B:E: AEIE Y
Bluetooth Slot: AGPO
Diagnostics EH-""'I:"' (Total): E'EF‘IEDT;B —
Disc Burnin endor. n (Ox 10de)

N ng Device ID: 0x0221
Fitira Channet Revision ID:  Ox00al
FireWire ROM Rmsinf: 2149a
Craphics/Displays Displays:
Mema AL2223W:
o ot Resolution: 1680 x 1050 @ 60 Hz

Depth: 32-bit Color

PCI Cards Core Image: Supported
Parallel SC5I Main Display: Yes
Power s gifl{“f'- E‘ﬁ

) nline: £5
Printers Quartz Extremeé: Supported
serial-ATA VA1930wm:
USE Resolution: 1440 x 9300 @ 60 Hz

¥ Network Depth: 32-bit Color
AirPort Card ﬁ?:fﬂ'r’_“ﬂ‘!f g#:-pnrted
Firewall Online: Yes
Locations Quartz Extreme: Supported
hndemic
Success!

You should download and occasionally run the Temperature Monitor utility. It’s a piece
of freeware that tracks internal temperatures, including the video card. If the system
climbs to dangerously high levels (say, 90° C), I'd shut it down to avoid damage. This is
particularly important in hot seasons, where you're well-served to actively cool any room
with a computer (you did install a fan, right?).
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Card Performance

Here’s what the Mac performance software XBench said about my Cube’s 1.3Ghz G4 CPU
and new XFX 6200 card running a single monitor.

¥ Results
# System Info
¥YCPU Test
GCD Loop
Floating Point Basic
AltiVec Basic
vecLib FFT
Floating Point Library
» Thread Test
»Memory Test
¥ Quartz Graphics Test
Line
Rectangle
Circle
Bezier
Text
¥ OpenGL Graphics Test
Spinning Squares
¥User Interface Test
Elements
*Disk Test

50.91

67.15
109.47
42.35
258.40
77.14
40.19
56.48
29.07
62.73
51.19
57.89
56.97
71.04
88.74
59.90
59.90
54.96
54.96
50.83

5.77 Mops [sec
1.01 Gflop[sec
10.30 Gflop/sec
2.54 Gflop [sec
7.00 Mops [sec

3.41 Klines fsec [50% alpha]
17.28 Krects/sec [50% alpha]
4.64 Kcircles/sec [50% alphal
1.79 Kbeziers /sec [50% alpha)
5.55 Kchars/sec

75.99 frames/sec

252.24 refresh/sec

Here’s the same configuration using two monitors, one at 1680x1050 and the other at
1440%x900. Performance drops less than 10% compared to the single monitor, which is

better than I expected.
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¥ Results 49.17
k> System Info

> CPU Test 66.37

*Thread Test 55.94

* Memory Test 29.04

¥ Quartz Graphics Test 59.14
Line 47.92  3.19 Klines/sec [50% alpha]
Rectangle 54.97 16.41 Krects/sec [50% alphal
Circle §2.37 4.27 Kcircles/sec [50% alpha)
Bezier 69.09 1.74 Kbeziers/sec [S0% alpha)
Text 83.99 5.25 Kchars/sec

¥ OpenGL Graphics Test 57.00
Spinning Squares 57.00 72.31 frames/sec

¥ User Interface Test 49.56
Elements 49.56 227.47 refresh/sec

The XBench site charts plenty of other Cubes with various configurations. I compared the
first dozen or so models with the same CPU speed and noticed a significant performance
edge in the Quartz Graphics and User Interface tests. Nothing to write home about, but a
nice confirmation of the $50 upgrade hard at work.

Summary

This upgrade turned a piece of affordable PC hardware into a high-level Cube performer.
My hands-on experience definitely helped, but it still took persistence, some optimism, and
a friend’s computer to make it happen. Anyone with an adequate supply of each should be
able to follow the footsteps to large monitor support and snappy video performance.

As the owner of an older Mac model, it felt like a revelation to add DVI and a second
monitor. A last thanks to the people at Strangedogs for prepping the XFX 6200 ROM and
hosting a support forum for like-minded users.

Copyright © 2007 Matthew Glidden, mglidden@atpm.com.
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Desktop Pictures

We need new desktop pictures each month. Write to us!

This Month’s Desktop Pictures

Lee Bennett spent a day last month at Tampa’s MacDill Air Force Base for the 2007 AirFest
and returned with hundreds of photos. After selecting some favorites, each received
a significant amount of adjustment, mostly with steps you can read about in his
Photoshop For the Curious columns for both this month and last month. Turns out
shooting up in the sky can really fool a camera’s meter—even the Nikon D100 used for
these shots.

Previous Months’ Desktop Pictures
Pictures from previous months are listed in the desktop pictures archives.

Downloading All the Pictures at Once
Some browsers can download an entire set of desktop pictures at once.

iCab Use the Download command to download “Get all files in same path.”
OmniWeb Choose “Save Linked > Images...” from the File menu.

Safari Use this Automator workflow.

Contributing Your Own Desktop Pictures

If you have a picture, whether a small series or just one fabulous or funny shot, feel free to
send it to editor@atpm.com and we’ll consider publishing it in next month’s issue. Have a
regular print but no scanner? Don’t worry. E-mail us, and we tell you where to send it so
we can scan it for you. Note that we cannot return the original print, so send us a copy.

Placing Desktop Pictures

Mac OS X 10.3.x and 10.4.x

Choose “System Preferences. ..” from the Apple menu, click the “Desktop & Screen Saver”
button, then choose the Desktop tab. In the left-side menu, select the desktop pictures
folder you want to use.

You can also use the pictures with Mac OS X’s built-in screen saver. Select the Screen
Saver tab which is also in the “Desktop & Screen Saver” System Preferences pane. If you
put the ATPM pictures in your Pictures folder, click on the Pictures Folder in the list of
screen savers. Otherwise, click Choose Folder to tell the screen saver which pictures to use.
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Mac OS X 10.1.x and 10.2.x
Choose “System Preferences. ..” from the Apple menu and click the Desktop button. With
the pop-up menu, select the desktop pictures folder you want to use.

You can also use the pictures with Mac OS X’s built-in screen saver. Choose “System
Preferences. ..” from the Apple menu. Click the Screen Saver (10.1.x) or Screen Effects
(10.2.x) button. Then click on Custom Slide Show in the list of screen savers. If you put
the ATPM pictures in your Pictures folder, you're all set. Otherwise, click Configure to tell
the screen saver which pictures to use.

Mac OS X 10.0.x

Switch to the Finder. Choose “Preferences...” from the “Finder” menu. Click on the
“Select Picture...” button on the right. In the Open Panel, select the desktop picture you
want to use. The panel defaults to your “/Library/Desktop Pictures folder. Close the
“Finder Preferences” window when you are done.

)
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Book Review

by Miraz Jordan, http://mactips.info

Digital Photography Expert Techniques,
Second Edition

Publisher: O'Reilly

Author: Ken Milburn

Price: $45

Trial: Portions via Google Books.

GOOD

This is a big book. At 404 pages it’s not one to slip into the camera bag for

a quick reference. Which is not surprising, really, because the title is quite misleading. This
book is not about techniques for photography, which, to my mind, is the art of capturing
pictures with a camera. Instead, it’s about techniques for manipulating photographs.

Digital Photography
Expert Techniques

The book describes a professional’s workflow for using Photoshop CS2 to work with digital
photos. As part of that workflow, it describes in excellent detail many steps for correcting
and improving images.

What’s in the Book

The first few chapters cover preparation: topics such as winnowing the shoot, making
backups, learning brief tricks for steady shooting, and using suitable equipment. The book
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then moves into specific workflow techniques for using Photoshop CS2, including Bridge
and Camera Raw.

Chapters five to eleven, about half of the book, provide detailed techniques for working with
images to enhance and combine them, while the final chapters are about sharing photos
through print and the Web.

The Audience and the Workflow

The Introduction says this book “is for photographers who are serious about producing the
highest quality photographs in the most efficient and cost-effective way possible.” The key
word there is “serious.” This book really is for professional photographers, or those who
are as serious about their photography as professionals are.

For professionals, workflow is very important: each captured image is an asset (or liability)
to be backed up or discarded, shared with clients, processed, and presented.

For me, a purely amateur, hobbyist photographer, the central chapters about image ma-
nipulation have value, but much of the workflow discussion is well beyond my needs.

Software Requirements

Many of the techniques require Photoshop CS2: for example, those using Bridge and Camera
Raw. Unfortunately, I skipped CS2 and am still using CS while I wait for my copy of CS3
to arrive. CS2 is required to use Camera Raw.

This meant that while I could read about many techniques, I was unable to try them out
for myself.

Image Manipulation
The chapters about image manipulation are very detailed, including useful information
about which techniques are destructive and tips on how to ensure you don’t destroy your
image when you use them.

There’s a lot of excellent information here. The steps are well laid out and straightforward
to follow, but the author does point out in his Introduction that readers unfamiliar with
the software may also need a beginning book on Photoshop.

I'm looking forward to trying out the techniques (and downloading the free workflow) once
my copy of Photoshop CS3 arrives.

Conclusion

I find the title misleading: I don’t think this book is about photography at all, but image
manipulation and workflow. Strongly oriented toward professional photographers, this is a
specialized book for a specialist audience.

If you're familiar with Photoshop CS2 and want to learn how to manipulate images, the
techniques in this book may be very valuable. An amateur photographer wanting techniques
for capturing better photos in the first place should look elsewhere.

ATPM 13.05 63 Review: Digital Photography Expert Techniques



I suggest you read some pages online through Google Books, or perhaps browse the book
carefully in the library or bookstore before purchasing to assess whether it’s right for you.

Copyright © 2007 Miraz Jordan. Miraz is a co-author of the recently published book: WordPress 2: Visual (
and member of the Webstock organizing team. Reviewing in ATPM is open to anyone. If you're

interested, write to us at reviews@atpm.com.
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Hardware Review

by Lee Bennett, Ibennett@atpm.com

Dock Extender

Developer: SendStation

Price: $29
Requirements: any iPod compatible with 30-pin dock connector.

Trial: None

. , o . EXCELLENT
I love it when a product simply does exactly what it is designed to do with
no fuss. SendStation’s Dock Extender is just such a product.
The complete Dock Extender, attached to a Keyspan TuneView base.
65 Review: Dock Extender
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It comes in three parts. The first—a small piece with a male dock connector jack on one
end and a female connection slot on the other—is the key component. Think of it as an
extension cord.

The second part is a piece that snaps into the standard Universal Dock indentation that
iPod dock-style products use. This base also has an upright metal stand for supporting the
iPod—obviously needed since the bottom of the iPod is no longer supported by the dock’s
indentation.

The last part is a hard rubber cap that fits over the top of the stand. Three different caps
of varying thickness are included to accommodate varying sizes of iPods, as well as the
thickness of the case in which you’ve placed your iPod.

Accounting for your iPod’s case is where the usefulness of the Dock Extender really shines.
You're probably well aware that most cases have to be removed before the iPod can slip
into a dock product. Since the Dock Extender’s Universal Dock insert raises the connector
above the dock’s indentation, you’ll no longer have to remove the case, provided your case
provides access to the port on the bottom of your iPod.
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The Dock Extender gives iPods a little lift.

As you can see in the above photo, my Marware Sportsuit case isn’t exactly the thinnest
case on the market (which is fine with me, since I like the padding protection). In addition,
the metal piece on the case used for attaching a belt clip makes the back even thicker. Even
the smallest rubber cap seemed to make the iPod sit a bit snug against the support. No
worries. Just turn it around backward—or even remove it entirely.

But as you can also see in the photo, the Sportsuit case slips snugly down over the top of my
iPod and encloses around the bottom. Without the Dock Extender, I either had to tug it
completely off, or squeeze the bottom of it up high enough to fit into the dock indentation.
I didn’t like the latter of those options because it was causing a crease in the clear plastic
on the front over the lower portion of the click wheel. Now, with the Dock Extender, I only
have to pull up the case a tiny bit around the edge—enough to expose the connection port.
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Since the actual extension portion of this product is a separate piece, in the rare cases where
it isn’t feasible to use the Dock Extender base, the extension piece can also be used alone.
I’ll leave it to your own means to determine if and when this would be necessary for you.

There’s only one shortcoming of the Dock Extender. It doesn’t come in black—yet! In
addition, though not a shortcoming, a possible point of contention is the price. Personally,
I feel it’s a reasonable value, but I expect there’ll be potential customers who feel, as I do,
that the Dock Extender seems like a $15 or $20 product—mnot $30.

Yet, if you're in love with a particular iPod case that you’d preferably never have to remove,
$30 may be a small price to pay for the ability to attach your iPod to a dock without the
gyrations needed to remove the case.

Copyright © 2007 Lee Bennett, Ibennett@atpm.com. Reviewing in ATPM is open to anyone. If you're

interested, write to us at reviews@atpm.com.
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Accessory Review

by Chris Lawson, http://chrislawson.net

Elevator

Developer: Griffin Technology

Price: $40 o AT
oy
i

Trial: None q‘f a i
Griffin’s iCurve was, for quite some time, the definitive laptop stand for “gxcELLENT
multi-monitor and desktop use. While it’s still for sale, its design has

been superceded by the new Elevator, which matches better with Apple’s current aluminum
design aesthetic.

The two stands are functionally almost identical, with the Elevator using acrylic only for
the cross-piece that connects the two aluminum risers topped by sticky grey silicone rubber.
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The major improvement of the Elevator over its predecessor is the Elevator’s ability to
collapse into a fairly small box for portability, making it easy to move from place to place.
The iCurve and similar stands (perhaps with the exception of Contour Design’s NoteRiser)
had long suffered from a need for bulky packaging and awkward portability, making them
difficult to toss into a backpack or messenger bag for the occasional trip to the office.
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Granted, an external keyboard and mouse are a requirement with any similar stand, and
keyboards and mice tend not to be especially portable either, but there are certainly times
when the Elevator’s collapsibility comes in very handy. You can’t fit an iCurve into a
suitcase and ship it across the country in a move, for instance.
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My only small gripe with this stand is its price, officially set by Griffin at $40. The iCurve
was introduced at the same price and can now be had for $10-15 less, and a quick check with
Froogle—I mean, “Google Product Search”—shows similar street prices for the Elevator.
I understand that R&D costs money, and attractive design has its own price, but Griffin
could easily price this stand at $30 and still make a healthy profit.
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That said, the Elevator does exactly what it claims, and does it very well. Griffin took
an excellent product and made it even better and more attractive. I have absolutely no
problem recommending this stand to anyone who uses a laptop on a desk for extended
periods of time, and its portability has made it the new king of the desktop-style laptop
stands.

Copyright © 2007 Chris Lawson. Reviewing in ATPM is open to anyone. If you're interested, write to

us at reviews@atpm.com.
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Software Review

by David B. Thompson, dthompson@atpm.com

Pando 1.5.5.1

Developer: Pando Networks

Price: Free version or paid subscription (see text)

Requirements: Mac OS X 10.3.9. Universal.

Trial: Fully-featured (limited server storage, downloads, and bandwidth)

EXCELLENT

A couple of months ago, I needed to send my wife a set of images. Although

each image was only a couple of megabytes in size, the lot of images amounted to more
than 80 megabytes. I could have uploaded them to my Web site and sent her a link. But
I have limited storage and limited bandwidth (not terribly limited, but there is a limit).
I didn’t want to send 40 e-mails, each with a single image, because of the hassle on both
ends. Furthermore, most e-mail servers limit attachments to a few megabytes anyway. (For
example, .Mac limits attachments to five megabytes. Gmail also has a limit, but it’s larger,
maybe ten megabytes. Most companies limit attachment size as well.)

So I needed a solution to my problem. When I had my Linux boxes at the university, one
of them was set up to be a Web server. When I had a batch of images to send to someone,
I put them in an archive, uploaded them to my server, and e-mailed a link to the recipient.

But I no longer work at the university, and I didn’t really want to use my Web site bandwidth
to send images. So I needed an alternative. Enter Pando.

Installation and Use

Like almost every OS X installation I've done, installation is simple. I downloaded the disk
image, mounted it, and copied the Pando software to the Applications folder.

There are four entries on the Preferences pane: General, Transfers, Storage, and RSS.
Contact information is entered on the General tab. If you prefer, Pando can be added to
the list of programs to open on login. I prefer to start the service when I need it. Your
mileage may vary.

ATPM 13.05 74 Review: Pando 1.5.5.1


mailto:dthompson@atpm.com
http://www.pando.com
http://www.apple.com/universal/
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1

Settings: __ Start Pando when | log in to Mac OS X
@ Show Pando transfer status icon in menu bar

Full name: David Thompson

Email: i

Your email address will only appear in private emails you
send with Pando. Your privacy is very important to us.

Account: Pando Free p(j]ﬂ[j{}

File size limit: 1CGE
Upgrade

(i Revert To Defaults :ﬁ

On the Storage tab, I entered the location I want Pando to store inbound files. I put mine in
my regular downloads folder—that may not be the most intelligent choice because inbound
files are intermixed with my browser downloads. But Pando has a facility for revealing
downloaded files. Inbound files could be put somewhere else, if you preferred. If you want
to preserve some upstream bandwidth, a throttle is available on the Transfers tab. I usually
just let mine run. If you use a proxy, there is a setting for that, too. All in all, configuration
was pretty simple.

I don’t have time to read (more) RSS feeds, so I have not explored that option.
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The main program window has one pane with three options. The received listing shows the
inbound files you received or those in progress. The snapshot below shows the file one of
my students sent for my review. (It’s boring technical stuff so don’t ask!) The sent listing
shows outbound files, although my sent-files list is currently empty.
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Sending a file is simple. Click the Send New button, and a dialog appears. Enter the
recipient’s e-mail address (or IM) in the To field, browse or drag files and/or folders, and
name the package. Below the file list is a Subject line and a Message box. When I sent
my wife the archive of images, I used “Images for you” for the subject and wrote a short
(very short) message. When everything suited me, I clicked the Send button, my file began
uploading, and an e-mail was sent to her.
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There are limitations to the service. The free service limits uploads to a gigabyte of files
at a time. Packages expire in 14 days. Server storage is limited to five gigabytes. Only ten
recipients per upload are allowed. Download speeds are throttled.

The limitations can be alleviated by purchasing more service. Pando offers four levels of
service at a range of prices. The prices don’t seem out of line if you need this service.

Conclusions

I sometimes need to send files larger than appropriate for an e-mail attachment. Most of
us don’t have access to an FTP site, and we wouldn’t want our personal files accessible via
that fashion anyway. A Web server is a possibility. But many people don’t have a Web site,
and most don’t know how to set up a drop zone anyway. The need exists for some way to
send large files.

The Pando software and service fills this need. Pando is kind enough to offer a free level of
service. I tried it, and it just works. It’s clean and, dare I say it, it works with Windows.
In my opinion, this is an excellent program and service. It fills a real niche.
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Hardware Review

by Lee Bennett, Ibennett@atpm.com

PocketDock Line Out USB

Developer: SendStation

Price: $30

Requirements: 4G or 5G iPod, 1G or 2G iPod nano, or iPod mini. 3G iPod should
use PocketDock Line Out FireWire instead.

Trial: None EXCELLENT

A frequent scenario in which I use my iPod sees it attached to an input of a studio sound
mixer and providing background music between sections of a live Internet streaming broad-
cast. There’s already a stereo 3.5mm to dual RCA cable connected to the board so, when
I come in, I simply plug the 3.5mm jack to the headphone port of my iPod.

There are two problems with doing this. The first one gets mixed opinion. Some people
will tell you it’s perfectly fine to send audio out to a mixer in this manner. But I believe the
audio quality may not be as good as it could be because the mixer is expecting a line-level
signal and not the already-amplified signal intended for headphones.

The second problem is that I can’t even count how many times I've went to navigate the
menus looking for a particular song and changed the volume on what was playing live by
accidentally brushing the click wheel volume control.

A small device to tap the line-level output from the iPod’s dock connector seemed like a
no-brainer. In all this time, however, short of bringing a standard-size dock with me, I've
never come across such a device—until now.
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The PocketDock is a miniaturized version of Apple's standard dock.

There are no frills to this product. Just like the standard Apple dock, the PocketDock
provides access to the line-level audio output via a 3.5mm jack. As you would expect, you
can also use the PocketDock to sync your iPod or access it as a mountable drive. The
surprise here is that the USB connection is the common type B jack used by nearly all
USB peripherals such as inkjet printers. It means you don’t have to carry the special dock
connector cable when you travel—only the ultra portable PocketDock.

If you're having some cognitive dissonance over this USB port and the fact that you still
have a 3G iPod that will only sync over FireWire, SendStation has you covered. Naturally,
I had this USB version sent to me for review since it is needed for my 5G iPod. But
SendStation also sells a version with a standard 6-pin FireWire connector in addition to the
3.bmm audio jack. There’s even a model that has both USB and FireWire jacks, though
this version lacks the audio jack. Finally, if you need a FireWire connection, don’t need the
audio jack, and you're on a very tight budget, a FireWire-only model is also available.

For the models that include the audio jack, you’ll be pleasantly surprised to discover that
SendStation didn’t leave you on your own to obtain the proper audio cable. While you can

ATPM 13.05 82 Review: PocketDock Line Out USB



certainly carry only the PocketDock alone for maximum portability, two cables are included
in the PocketDock Line Out package. One is a male-to-male 3.5mm stereo patch cable, and
the other is a stereo 3.5mm to twin phono/RCA cable.

Kudos to SendStation for including the two commonly needed audio cables for an iPod's audio output.

The included cables also lend themselves to ultra portability. Both sport integrated Velcro®
strips to keep the cables wrapped.

One extra touch is the inclusion of a plastic cover that fits over the PocketDock’s dock
connector (the small dark piece laid beside the PocketDock in the above photo). It has a
loop that can be attached to a keychain. When I first learned of the loop’s purpose, I wasn’t
sure I'd ever feel safe in putting it on a keychain for fear that the PocketDock would slip
off. Surprisingly, however, it stays on very well, thanks to the small metal clips on either
side of the dock connector and the protruding bumps of plastic inside the cover which catch
the metal clips. Granted, I would still never use this feature if my keychain dangled out in
the open, but if, like me, you keep your keys in your pocket or some other enclosed space,
this keychain cover might prove very useful.
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The only way this product could be improved is if it were available in black, and if it also
included a video output jack.

Wait, what’s that? You want a video output jack too? Ask, and ye shall receive. Very
recently, SendStation announced the PocketDock AV which, in addition to the USB and
line out ports, also sports an S-video out port. At publication time, the PocketDock AV
was not yet shipping, but it should be available soon.

And it comes in black, too!

Copyright © 2007 Lee Bennett, Ibennett@atpm.com. Reviewing in ATPM is open to anyone. If you're

interested, write to us at reviews@atpm.com.
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Software Review

by Ed Eubanks, Jr.

Yep 1.5.2

Developer: Ironic Software

Price: $34

Requirements: Mac OS X 10.4. Universal.
Trial: Fully-featured (21 days)

YERY MICE

Most Mac users have more than a few PDFs on their hard drive—in fact,

most have far more than they remember or realize. PDF has become the document format
of choice for exchanging among multiple users or across platforms, and with “Save as PDF”
built into Mac OS X, most Mac users have amassed quite a collection of PDFs on their
Macs.

You have probably dealt with the problem in one of three ways: done nothing (and spent
valuable time searching for the right file when you need it); developed a growing Franken-
stein of a file system through Finder, with complex nested and hierarchical folders; or
invested time (and probably money) in one or more of the growing number of “digital file
cabinet” applications that are available. With either of the first two, you may have become
frustrated at times with the difficulty of finding what you want. With the latter, you may
have found that these applications, while capable and often quite powerful solutions, are
much more than you need.

If any of these describe you, Yep may be just what you need.

Yep is touted as “iPhoto [or iTunes| for PDFs” and frankly, that is not far off. Like iTunes,
Yep offers no ability to edit its contents—rather, it allows the editing and/or addition of
metadata. And like iPhoto, Yep gives the user thumbnail versions of each PDF (resizable
like iPhoto, as well) that can be organized into collections. Indeed, it is clear that much of
the interface was borrowed from iPhoto—and they could certainly do worse.

When you first open Yep, it scans your hard drive for PDF files; depending on the size of
your drive (and the number of PDFs), this can take a few minutes. Soon, however, Yep
opens a window that looks somewhat familiar for anyone who has used iPhoto: thumbnail
view in the main panel (plus two additional panels: on the left is an organization panel,
while the right panel contains file details). Users will quickly notice that Yep has intuited
tags (or keywords) from their PDFs—even though no such metadata need exist for PDFs
in Finder. This is done through Spotlight’s indexing of these documents—in most cases,
something that has already been done, which saves a lot of time on the front-end.
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Yep's window upon opening, showing Tags view in the left panel, thumbnails in the main panel, and detail
summary in the right panel.

The concepts of metadata and tags have arisen as powerful tools over the past few years.
Metadata, which is essentially information that is attached to a file or folder but is not
immediately visible, has been around for years; Microsoft began applying metadata such
as author information and modification date within Word generations ago, and operating
systems (Apple’s and others) have been using it for much longer. But until recently, it has
been the parlance of the power-user; now, however, it is a tool for the masses. Many users
have developed their own “taxonomy” for organizing files with tags. Borrowed from the
sciences, a taxonomy is a hierarchical categorization for many items of varying degrees of
similarity and difference.

These tags are the key to what makes Yep a useful program: the more you use them, the
more Yep can help you find what you want. When you click on a single PDF in this browser,
the Details panel switches from a summary of the whole database to a thorough tagging
pane, with tagging options for name, author, description, location, URL, and of course,
tags related to a taxonomy you have developed. Multiple PDFs can be selected at once
for bulk tagging, and over time the Auto-Tag feature becomes more accurate and will save
time and work.

The Tags view is one of three choices for viewing the organization of PDFs—it includes
an editable list of all tags that vary in size depending on usage—larger tags occur more
frequently, while smaller tags indicate fewer instances. Collections are another option,
with a more traditional way of viewing files iTunes/iPhoto style—you can construct Smart
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Collections or plain-vanilla Collections. Tracking Locations is the third option, allowing
you to see where the file lives in Finder. Users can also toggle either thumbnails or a list in
the main panel.
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Here is the Track Locations option in the left panel, list view in the main panel, and detail for a single file in
the right panel.

PDFs are automatically indexed when Yep opens, but more advanced options are available
here. A preferences option allows the user to specify what folders and locations will be
scanned for new PDFs. Yep has its own Documents folder, and new PDFs can be created in
it through a “Save PDF to Yep” option that is added to the PDF menu in any Print dialog
(via Mac OS X 10.4’s PDF Services feature). Yep also supports any TWAIN scanner, as
well as the Fujitsu ScanSnap (which I reviewed in the March issue). It is fairly easy to add
or exclude PDFs from Yep, and they always exist as stand-alone PDFs in Finder (in other
words, they aren’t added to a proprietary database).

Developed by a pair of programmers who have a track record of good products (they
also developed Starry Night and The Body Journal), Yep seems to have been built with
academic users in mind. Yep can search a specified Web site for related papers or articles,
so research is made easier; it is set by default to Google Scholar, but any Web site (PubMed,
Scirus, or the site of your choice) can be named in the preferences.

Yep has a handful of other tools and features, including a loupe for quick viewing of PDFs
in the thumbnail browser (a feature I didn’t find particularly helpful), good contextual
menus through either right-clicking or an action menu along the bottom of the window,
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and lots of customizing and hiding: you can hide the details panel and the toolbar, and
you can set lots of options for the tag cloud. Maybe one of the best advanced features is
the option to write tags built in Yep to the file’s Spotlight comments (giving you much of
the same search capability everywhere else in the Finder as well). It is also possible to use
Yep collaboratively over a network, and to sync it between multiple Macs.

If you are already a satisfied user of DEVONnote, DEVONthink, Yojimbo, EagleFiler, or
a similar product, Yep will probably not be for you. It is not nearly as powerful or format-
compatible as any of these (nor is it intended to be), and if you need that sort of flexibility
then Yep will likely frustrate you. Yep offers no support for document formats other than
PDEF, and no real editing ability is included. Yep is designed for the very specific function
of organizing PDFs—period.

On the other hand, if you work exclusively (or nearly so) with PDFs and/or you've found
programs like DEVONthink and even Yojimbo to be overkill, Yep may be the thing for you.

Update: Version 1.6

The latest version, made public after this review was written, brings a few minor tweaks.
Most notable are the improved tagging preferences, now giving the user more control over
auto-tagging; and an improved loupe with an option for full-page viewing (which makes it
much more useful). Version 1.6 doesn’t change my assessment of Yep overall—it is a fine
program with a useful niche for those who need more power in PDF management.

Copyright © 2007 Ed Eubanks, Jr. Reviewing in ATPM is open to anyone. If you're interested, write

)

to us at reviews@atpm.com.
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FAQ: Frequently Asked Questions

What Is ATPM?

About This Particular Macintosh (ATPM) is, among other things, a monthly Internet mag-
azine or “e-zine.” ATPM was created to celebrate the personal computing experience. For
us this means the most personal of all personal computers—the Apple Macintosh. About
This Particular Macintosh is intended to be about your Macintosh, our Macintoshes, and
the creative, personal ideas and experiences of everyone who uses a Mac. We hope that we
will continue to be faithful to our mission.

Are You Looking for New Staff Members?

ATPM is looking to add more regular reviewers to our staff. Though all positions with About
This Particular Macintosh are volunteer, reviewing is a great way to share your product
knowledge and experience with fellow members of the Macintosh community. If you're
interested, contact ATPM’s Reviews Editor, Paul Fatula.

How Can | Subscribe to ATPM?
Visit the subscriptions page.

Which Format Is Best for Me?

e The Online Webzine edition is for people who want to view ATPM in their Web
browser, while connected to the Internet. It provides sharp text, lots of navigation
options, and live links to ATPM back issues and other Web pages.

e The Offline Webzine is an HT'ML version of ATPM that is formatted for viewing
offline and made available in a Mac OS X disk image. The graphics, content, and
navigation elements are the same as with the Online Webzine, but you can view it
without being connected to the Internet. It requires a Web browser.

o The Print PDF edition is saved in Adobe PDF format. It has a two-column layout
with smaller text and higher-resolution graphics that are optimized for printing. It
may be viewed online in a browser, or downloaded and viewed in Apple’s Preview or
Adobe Reader on Macintosh or Windows. PDFs may be magnified to any size and
searched with ease.

o The Screen PDF edition is also saved in Adobe PDF format. It’s a one-column
layout with larger text that’s optimized for reading on-screen.

How Can | Submit Cover Art?

We enjoy the opportunity to display new, original cover art every month. We're also very
proud of the people who have come forward to offer us cover art for each issue. If you're a
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Macintosh artist and interested in preparing a cover for ATPM, please e-mail us. The way
the process works is pretty simple. As soon as we have a topic or theme for the upcoming
issue we let you know about it. Then, it’s up to you. We do not pay for cover art but
we are an international publication with a broad readership and we give appropriate credit
alongside your work. There’s space for an e-mail address and a Web page URL, too. Write
to editor@atpm.com for more information.

How Can | Send a Letter to the Editor?

Got a comment about an article that you read in ATPM? Is there something you’d like
us to write about in a future issue? We'd love to hear from you. Send your e-mail to
editor@atpm.com. We often publish the e-mail that comes our way.

Do You Answer Technical Support Questions?

Of course (although we cannot promise to answer every inquiry). E-mail our Help Depart-
ment at help@atpm.com.

How Can | Contribute to ATPM?

There are several sections of ATPM to which readers frequently contribute:

Segments: Slices from the Macintosh Life

This is one of our most successful spaces and one of our favorite places. We think of
it as kind of the ATPM “guest room.” This is where we will publish that sentimental
Macintosh story that you promised yourself you would one day write. It’s that special place
in ATPM that’s specifically designated for your stories. We’d really like to hear from you.
Several Segments contributors have gone on to become ATPM columnists. Send your stuff
to editor@atpm.com.

Hardware and Software Reviews

ATPM publishes hardware and software reviews. However, we do things in a rather unique
way. Techno-jargon can be useful to engineers but is not always a help to most Mac users.
We like reviews that inform our readers about how a particular piece of hardware or software
will help their Macintosh lives. We want them to know what works, how it may help them
in their work, and how enthusiastic they are about recommending it to others. If you have
a new piece of hardware or software that you’d like to review, contact our reviews editor at
reviews@atpm.com for more information.

Shareware Reviews

Most of us have been there; we find that special piece of shareware that significantly im-
proves the quality our Macintosh life and we wonder why the entire world hasn’t heard
about it. Now here’s the chance to tell them! Simply let us know by writing up a short
review for our shareware section. Send your reviews to reviews@atpm.com.

Which Products Have You Reviewed?

Check our reviews index for the complete list.
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What is Your Rating Scale?

ATPM uses the following ratings (in order from best to worst): Excellent, Very Nice, Good,
Okay, Rotten. Products rated Good or better are ones that we recommend. Okay products
get the job done. We recommend avoiding Rotten products.

Will You Review My Product?

If you or your company has a product that you’d like to see reviewed, send a copy
our way. We're always looking for interesting pieces of software to try out. Con-
tact reviews@atpm.com for shipping information. You can send press releases to
news@atpm.com.

Where Can | Find Back Issues of ATPM?

Back issues of ATPM, dating since April 1995, are available in DOCMaker stand-alone
format and as PDF. In addition, all issues since ATPM 2.05 (May 1996) are available in
HTML format.

What If My Question Isn’t Answered Above?

We hope by now that you’ve found what you’re looking for (We can’t imagine there’s
something else about ATPM that you’d like to know.). But just in case you've read this
far (We appreciate your tenacity.) and still haven’t found that little piece of information
about ATPM that you came here to find, please feel free to e-mail us at (You guessed it.)
editor@atpm.com.

)
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